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Introducao

Vocé ja conhece o Adobe Photoshop? Este software se tornou referéncia no tratamento de fotos no mundo
inteiro, e por esse motivo, neste capitulo, vocé conhecera suas ferramentas e possibilidades. Para comecar, vocé
terd acesso a interface do Adobe Photoshop a partir de seus principais elementos: menus, painéis e botdes. Com
isso, vocé se sentird mais familiarizado com este software e tera mais dominio sobre seu uso.

Logo depois, vocé conhecera o conceito de pintura digital, planificagio e manipulacdo de imagens. Mas como
comecar a trabalhar com essas técnicas? Procurando responder a esta pergunta, serdo apresentados os
comandos iniciais do programa. Desse modo, vocé adquirird no¢des sobre como criar um novo arquivo, abrir um
arquivo criado anteriormente, bem como salva-lo, exporta-lo e importa-lo.

Em seguida, vocé conhecerd as ferramentas basicas deste software, como a 1til e famosa ferramenta da varinha
magica de selecdo e suas evolugdes, que facilitardo bastante o seu trabalho. A possibilidade de criar e
transformar figuras basicas, as ferramentas de pintura, edigio e retoque de imagens disponiveis no software sdo
os grandes diferenciais dele.

Mas o que torna o Adobe Photoshop tdo poderoso, afinal? A oportunidade de trabalhar com camadas - que vocé
estudara neste capitulo - facilita muito o trabalho tanto de criagdo quanto de manipulacdo de imagens, e ha
mascaras, filtros e efeitos de blending que podem garantir as imagens efeitos de grande destaque. Além disso, a
utilizagdo da separacdo de canais e recortes agiliza e organiza os trabalhos desenvolvidos no Adobe Photoshop.
Temos certeza de que sera muito proveitoso para vocé conhecer o grande software de tratamento e retoque de
imagens do mercado mundial, que define padrdes para os concorrentes e virou requisito basico para
profissionais da fotografia. Vamos comecgar?

Abragos e bons estudos!

3.1 Conceitos basicos

Criado em 1987, o Adobe Photoshop é um programa de manipula¢cdo de imagens bitmap criado pela Adobe
Systems e figura entre os mais importantes do mercado de fotografia mundial, possuindo grande qualidade e
ferramentas poderosas de edicdo. Ele faz parte da suite Adobe Creative Cloud que, por meio de assinatura, o
distribui com softwares como o Adobe Illustrator, o Adobe Indesign e o Adobe Lightroom, sendo que este ultimo
o complementa no tratamento de fotografias.

A Adobe Systems (2018) define o Photoshop como “o melhor software de edicdo de imagens e design grafico”.
Com ele, segundo a Adobe Systems (2018), é possivel aprimorar fotos, ilustracées e ilustragdes 3D, bem como
produzir sites e aplicativos para dispositivos moveis, editar videos e simular pinturas em tempo real, além de
outras possibilidades.
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VOCE O CONHECE?

% Antes da fama do Photoshop, Thomas Knoll, um de seus criadores, produzia sua tese de

doutorado em 1987, na Califérnia quando desenvolveu um cddigo de programacdo que
possibilitava, nos monitores em preto e branco da época, a exibicdo de imagens em escala de
cinza. Foi assim que se deu inicio ao cddigo do poderoso Adobe Photoshop (CORREIO
BRAZILIENSE, 2010).

Apesar de existirem alguns softwares pagos e gratuitos que concorrem diretamente com o Photoshop, como o
Corel PHOTO-PAINT, o PhotoScape, o Pixlr, o GIMP e o Pixelmator, com diversas similaridades, eles nao sdo tdo

bem-sucedidos quanto o software da Adobe.
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Figura 1 - Interface padrdao do Adobe Photoshop CC no macOS.
Fonte: Elaborada pelo autor, baseada em ADOBE PHOTOSHOP CC, 2018.

A interface do Photoshop é muito semelhante aos outros aplicativos da Adobe. Isso se deve a unificacdo dos
programas sob uma tunica plataforma: o Adobe Creative Cloud, que funciona como uma assinatura mensal e
oferece os aplicativos pelos quais vocé se interessa (pacote completo, edi¢do de video ou essencial fotografia)
por precos compativeis com a quantidade de facilidades. Barras de tarefas, dos menus e dos botdes que
executam as principais tarefas desse aplicativo sdo posicionados em locais iguais aos outros softwares da

empresa.
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3.1.1 BITMAP X VETOR

0 Photoshop é um software de edigdo bitmap. Esse tipo de imagens é composto por elementos de imagens - ou
pixels -, pequenos pontos que se aglutinam e contém informagdes sobre cor. Nesse tipo de imagem, é possivel
ver os pontos ao aplicar zoom. Desse modo, segundo Ambrose e Harris (2012, p. 96), “Os graficos de bitmap
geralmente ndo podem ser ampliados porque tém uma resolucdo fixa, ou seja, quando vocé redimensiona a
imagem, ela pode ficar distorcida e irregular, pixelada”.

Ja as imagens vetoriais utilizam desenhos geométricos em sua composi¢cdo, como curvas, linhas e poligonos.
Esses desenhos sdo recalculados sempre que sdo feitas modificagdes. Assim, ao contrario dos bitmaps, podem
ser redimensionadas sem perder a qualidade, pois os softwares vetoriais sempre refazem os calculos e
reapresentam a arte (BERTOLETTI; CAMARGO, 2016).

3.1.2 Ferramenta

Com uma ferramenta tdo complexa em maos, é importante conhecer suas opg¢oes e detalhes da interface. Neste
topico, vocé explorara cada item da tela, familiarizando-se com suas fun¢des. Vamos 147 Clique e confira.

Barra de menus

Contém os principais comandos do aplicativo, como os seguintes menus: Arquivo (File), Editar (
Edit), Imagem (Image), Camada (Layer), Tipo (Type), Selecionar (Select), Filtro (Filter), 3D, Exibir (
View), Janela (Window) e Ajuda (Help). No Windows, fica posicionado na parte superior do

Photoshop, e no macOS, em sua barra de menus.

Barra de opgdes

Disponibiliza uma série de recursos que sdo modificados de acordo com a ferramenta ativa.
Exemplo: ao clicar na ferramenta texto, aparecem opg¢des de selecdo de fonte, paragrafo e
renderizag¢do do texto.

Barra de ferramentas

Nesta barra, o Photoshop disponibiliza todas as ferramentas para manipulacdo de imagem,
selecdo, preenchimento, vetores, lupa, efeitos etc.

Painéis de encaixe

Possibilitam a edi¢do do arquivo e agdes. Com eles, vocé pode alterar cores, modificar fontes,
personalizar camadas, aplicar efeitos, entre outras op¢des. Todos os painéis de encaixe estdo
disponiveis no menu Janela (Window). Ao abrir os painéis, ainda existem botdes que habilitam

mais opgoes.

Barra de status
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Exibe informagdes sobre o arquivo, ferramenta em uso, perfil de cor, peso da imagem para a
internet, além de possibilitar a sele¢do de zoom e controle de camadas. Ao clicar na seta, a barra de
status abre um menu suspenso que oferece outras possibilidades de visualizacdo de informacdes.

Que tal testar?

Réguas e guias

Auxiliam na diagramacdo da imagem e identificam as coordenadas de localizagdo na prancheta.
Vocé pode ativar a régua com o comando CTRL + R ou Command + R.

Unidades de medida

Disponibiliza unidades de medidas para a edi¢do do arquivo, como guias, redimensionamento,
entre outras opg¢des. Ao criar um arquivo, vocé escolhe alguns parametros, como unidades de
medidas, mas elas podem ser alteradas facilmente em: Editar (Edit) > Preferéncias (Preferences)

Unidades e réguas (Units & Rulers) > Escolher a Unidade de medida desejada > Confirmar.

A seguir, conhega uma dica sobre a interface do Photoshop.

VOCE SABIA?

Vocé pode modificar a sua interface de acordo com as suas necessidades, mas se quiser voltar a

configuracdo padrdo, basta clicar em Janela (Window) > Espago de Trabalho (Workspace) >

Redefinir Essenciais (Reset Essencials), que o Photoshop voltara ao padréo de instalagdo.

Agora que vocé ja conhece a interface padrdo do Photoshop, conhega também, na sequéncia, os recursos e
ferramentas desse grande aplicativo de manipulagio de imagens.
Para comegar, vocé conhecera as fungdes iniciais do Photoshop. Elas sdo bem simples e possibilitam iniciar um
novo trabalho ou alterar algum arquivo ja existente.
¢ Abrindo um arquivo: na versdo Windows, vocé pode abrir um arquivo de duas formas: arrastando o
arquivo para dentro da janela do aplicativo ou pelo menu Arquivo (File) > Abrir... (Open...). Na versdo
macOS, vocé ainda pode abrir o arquivo arrastando-o para o icone no dock. Os principais formatos
suportados por ele sdo: .psd, .jpg, .pdf, .tiff, .png, .eps, bmp, entre muitos outros.
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VOCE SABIA?

Apesar de o Photoshop trabalhar com camadas, essa informagdo s6 pode ser guardada em

poucos formatos de arquivos, entre eles o PSD, o PSB e o TIF. Os outros formatos ndo guardam

as informacgdes de camadas e irdo mescla-las ao serem salvos.

¢ Criando um novo arquivo: para criar um novo arquivo no Photoshop, vocé deve clicar no menu
Arquivo (File) > Novo (New). Sera aberta uma janela com opg¢des de configura¢des do arquivo inicial
sobre tamanhos, tipos de medidas, orientagdo da pagina, modo de cor, cor de fundo e perfil de cor de
impressio, além de modelos pré-definidos. E possivel escolher entre vérios perfis (presets) de arquivos:
Foto (Photo), para trabalhos relacionados a manipulagdo fotografica; Impressao (Print), especificos para
impressdo e cores em CMYK; Artes e [lustracdes (Arts & Illustration), utilizado para pintura digital; Web,
com formatos compativeis com a internet; Mével (Mobile), para aparelhos como celulares e tablets; e
Filme e Video (Film & Video), com formatos padrdo de videos digitais. HA também a possibilidade de

baixar novos modelos a partir do Adobe Stock.
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Figura 2 - Janela Criar novo documento. Nela, é possivel efetuar configuracdes iniciais do seu arquivo.
Fonte: ADOBE PHOTOSHOP CC, 2018.

¢ Salvando um arquivo: para salvar um arquivo, clique no menu Arquivo (File) > Salvar (Save). Além
disso, vocé pode utilizar a opgao Salvar Como (Save As), que ird abrir uma janela que permitira alterar o
nome do arquivo, a extensao (tipo de arquivo) e o local de salvamento. Ao escolher salvar um arquivo, o
Photoshop oferece diversos formatos, desde os formatos da Adobe, como o .psd, o .psb e o .pdf, até
formatos largamente utilizados em bitmap, como o .jpg, o .bmp e o .tif. Além disso, o Photoshop possui
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uma opg¢ao especifica para salvar em formatos compativeis para a internet e em tamanho reduzido. A
opgao Salvar para Web (Save for Web) possibilita o salvamento em JPG, PNG (com ou sem transparéncia)
e Gif (com ou sem transpareéncia), otimizados para exibi¢do na internet e em formato comprimido.
Recentemente, na edi¢do CC 2017, essa opcao foi realocada para dentro do submenu Exportar. Para
encontra-la, clique em Arquivo (File) > Exportar (Export) > Salvar para Web (Save for Web). Também a
partir da versdo CC 2017, ainda, o Photoshop possui a op¢ao Exportar como (Export as), que permite
fazer o que é oferecido pelo Salvar para Web de forma mais automatizada.

¢ Importando um arquivo: para importar um arquivo, clique em Arquivo (File) > Importar Incorporado (
Place Embeded). A imagem serd inserida na prancheta de trabalho e incorporada ao arquivo principal.
Vocé ainda pode importar e manter os arquivos externos vinculados, utilizando a op¢do Arquivo (File) >
Importar Vinculado (Place linked). Nessa op¢do, sempre que vocé mudar o arquivo importado de lugar,
precisard atualizar o vinculo. Essas opg¢des permitem que sejam importados arquivos vetoriais (.ai, .pdfe .
eps) ou bitmap.

VOCE QUER VER?

O Photoshop nem sempre foi chamado assim, nem surgiu tdo grandioso como ¢ hoje. Ele foi um

0O

K experimento de dois irmaos, Thomas e John Knoll, que propuseram uma nova forma de tratar
imagens em computadores, inicialmente para computadores Apple, e posteriormente para
Windows. Com o tempo, eles foram langando versdes e evoluindo seu cddigo. Assista ao

resumo dessa histéria em: <https://www.youtube.com/watch?v=gBARKm_M32U>.

Agora que vocé conhece os comandos basicos do aplicativo, vocé ird se aprofundar em suas ferramentas para

criacdo e manipula¢do de imagens. Prossigal!

3.1.3 Pintura digital

Utilizando uma mesa digitalizadora ou o préprio mouse, o Photoshop transforma-se em uma tela para desenho e
ilustragdo, sendo possivel, entre outras coisas, pintar a partir do aplicativo. Com este software, é possivel ajustar
a sensibilidade do reconhecimento das ferramentas para que elas simulem o uso de pincéis reais.
O Photoshop possui uma série de ferramentas especificas para pintura digital, sio elas: Pincel (Brush); Borracha (
Eraser); Superesposicdo (Burn); Subesposicdo (Dodge); Conta-gotas (Eyedropper) e Dégradé (Gradient).
¢ Pincel (Brush): essa ferramenta simula a aplicacdo de pincéis em tela, que podem ser configurados de
acordo com a preferéncia do artista. Para mais op¢des dessa ferramenta, existe o painel de encaixe
Pincéis (Brushes). Com ele, hd a possibilidade de alterar o tipo de pincel facilmente, assim como
espessura e formatos especiais. Na barra de ferramentas, é possivel, ao segurar o botdo esquerdo do
mouse ou clicar com o botdo direito no botdo pincéis, selecionar outros tipos de pincéis, como o Mixer
brush, “que oferece flexibilidade e op¢des de combinagdo de cores e de pinceladas, como se vocé estivesse
pintando em uma tela de verdade” (FAULKNER; CHAVEZ, 2015, p. 221). Além dele, existe o lapis (pencil)
e a ferramenta Alteracgdo de cor (color replacement), que permite trocar a cor que estiver sendo pintada
na tela.

Borracha (Eraser): assim como o nome diz, essa ferramenta permite apagar areas da imagem. Vocé
pode configurar a pressdo da borracha, aumentando a for¢a da exclusio e também sua opacidade. Além
disso, ao clicar com o botdo direito do mouse nessa ferramenta, aparecem mais duas opg¢des de borracha.

A primeira delas é Borracha de Fundo (Background Eraser), muito util para apagar o fundo de imagens
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com muitos detalhes, como cabelos. Com ela, vocé pode selecionar a cor de fundo, e o Photoshop
reconhecera e protegera o restante da imagem da exclusdo durante o processo. A outra opgdo é a
Borracha magica (Magic Eraser), que permite clicar na cor que se deseja apagar e a reconhece em toda a

extensao da imagem.
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Figura 3 - Aplicacdo da ferramenta Borracha de fundo. Com ela, é possivel remover apenas uma cor da imagem,
separando o fundo da imagem em destaque.
Fonte: ADOBE PHOTOSHOP CC, 2018; Shutterstock, 2018 (com adaptacoes).

Na figura acima, foi aplicada a ferramenta borracha. Perceba que o fundo, que era composto por nuvens, foi
apagado, dando lugar a camada que estava atras da foto, de cor alaranjada.

3.1.4 Planificacdao

Por trabalhar com camadas, o Photoshop permite a separagdo delas em niveis de acordo com a sua necessidade,
assim como permite a planificacdo de todas elas em uma s6. A maioria dos formatos ndo permite salvar esse tipo
de informacdo, entdo é importante planificar antes de salvar o seu arquivo.

Para planificar camadas, existem alguns caminhos: vocé pode clicar nas camadas que deseja planificar, apertar o
botdo direito do mouse dentro da janela de camadas e clicar em Planificar Camadas, ou no Menu Camadas (
Layers) > Planificar Imagem (Flattern Image). Também é possivel mesclar camadas superiores as inferiores com
a combinacdo das teclas Ctrl + E (Command + E) quando a camada superior estiver selecionada. Assim, ela sera
mesclada com a camada imediatamente abaixo. Finalmente, é também possivel executar esse comando clicando
no menu Camadas (Layers) > Mesclar Camadas (Merge Layers), ou também pelo painel de encaixe, selecionando
as camadas que deseja mesclar e clicando nelas com o botdo direito, e depois na op¢ao Mesclar Camadas (Merge
Layers).
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3.2 Recursos basicos

A partir deste tdépico, vocé terd contato com as ferramentas para criagdo e manipulacdo de imagens desse
poderoso software de manipulagdo bitmap. Para isso, vocé iniciara este estudo pelas formas basicas e suas
transformacgdes. Logo em seguida, serdo exploradas a pintura, a edicdo de imagens e os retoques basicos.

Vocé vera que ndo é apenas com o pincel que o Photoshop permite criar: ele também oferece modos mais
simplificados de criar formas bdsicas, como retangulos, retangulos com cantos arredondados, elipses, poligonos,
linhas e formas personalizadas (que permitem que vocé defina como serd a sua forma). Essas formas sao
consideradas um falso vetor: elas sdo desenhadas do mesmo modo que no Illustrator (em vetor) e podem ser
rasterizadas (processo pelo qual o vetor é convertido em bitmap). Pronto para conhecé-las?

3.2.1 Criagao e transformacao de formas basicas

Clique e conheca os passos necessarios para se criar ou alterar uma forma basica.

Para criar uma forma basica, basta clicar no botdo de forma (normalmente, a forma que ira
aparecer neste botdo é o retangulo. Para altera-la, clique nele com o botao direito e escolha outra
que desejar) e desenhar a forma no seu arquivo.

Também é possivel criar uma forma definindo dimensdes: para isso, clique duas vezes no botao de
forma e a janela que aparecera oferecera essa opg¢ao de configuragao.

Como esse tipo de desenho é considerado um falso vetor, ele ndo tera as ferramentas de pintura e
coloracdo disponiveis no Photoshop. Desse modo, para alterar seu preenchimento e contorno, é
necessario utilizar a janela de encaixe Propriedades (Properties), que apresentard as possiveis
alteracgdes oferecidas pelo software.

Para transformar essas formas em uma imagem rasterizada, clique em Camada (Layer) >
Rasterizar (Rasterize) > Forma (Shape) ou, na janela de encaixe de Camada (Layer), clique sobre o
nome da camada e, depois, em Rasterizar (Rasterize), que ele transformara o objeto em camada

bitmap.

Sempre que estiver editando alguma camada ou objeto vetorizado, o Photoshop permite transformacgdes
(também é possivel fazer isso em sele¢des). Para tanto, use a combinagao de teclas CTRL + T (ou Command + T) e
o objeto apresentard op¢des de alteracdo de tamanho ao seu redor e de rotagdo. Além disso, ao clicar com o
botdo direito no objeto que estd sendo alterado, o menu apresenta outras opg¢des de transformagdo, como
Inclinar (Skew), Distor¢do (Distort), Deformacao (Warp), Perspectiva (Perspective), Tamanho de imagem com
conservacdo de fundo (Content-Aware Transform), Virar (Flip) e Deformacdo de marionete (Puppet Warp), que
cria um mapeamento pelo objeto, permitindo fazer alteracdes articuladas e simulando movimentos corporais.

3.2.2 Ferramentas de pintura, edi¢cao e retoque

Além das ferramentas de pintura, o Photoshop oferece ferramentas muito poderosas de retoque de imagem.
Essas ferramentas sdo utilizadas para replicar areas da imagem que podem corrigir detalhes e imperfeicoes,
como espinhas, manchas na pele em fotos de pessoas ou até objetos que ndo sdo desejaveis em fotos de prédios,

plantas ou qualquer outro tipo de imagem. Elas sdo muito uteis e eficientes, mas é importante salientar que:
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A quantidade de retoque aplicada depende da imagem na qual vocé esta trabalhando e de seus
objetivos para ela. Em muitos casos vocé talvez sé precise alterar a resolucdo, deixar a imagem mais
leve ou reparar uma mancha sutil. Em outros, talvez precise realizar diversas tarefas e empregar
filtros mais avang¢ados (FAULKNER; CHAVEZ, 2016, p. 32).

Clique e conheca, a seguir, algumas dessas ferramentas.

Ferramenta Clone

Utilizada para clonar areas da imagem que podem corrigir algum erro em outras areas. Para
utilizar essa ferramenta, clique no botao Clone da barra de ferramentas (que lembra um carimbo).
A seguir, clique na area que sera clonada com a tecla ALT do teclado pressionada e, sem a tecla
ALT pressionada, aplique a ferramenta na area a ser corrigida. Essa ferramenta aplica diretamente
a clonagem em cima da area corrigida e isso pode gerar um resultado muito visivel da alteracao.

Serd necessario suaviza-lo, em alguns casos.

Ferramentas Retoque

Sdo ferramentas que modificam os pixels de forma a retocar detalhes da imagem, como o Pincel de
Recuperacdo (Healing Brush), que remove manchas da area que estd sendo tratada, utilizando
como base uma area marcada (da mesma forma que a ferramenta Clone - com o icone de um
carimbo -, com a tecla ALT pressionada). O Pincel de Recuperagio de Manchas (Spot Healing Brush
) remove manchas e objetos na imagem. E possivel, por exemplo, remover espinhas e manchas da
pele. A diferenca dessa ferramenta para a ferramenta Clone é que a de Recuperag¢do de Manchas
suaviza a area ao redor da aplicagdo, tornando menos visivel a modificagao.

Ferramenta Correcdo (Patch)

Permite que vocé faga a corre¢do em uma area da mesma forma que a ferramenta Pincel de
Recuperac¢do, mas vocé pode definir o contorno de uma 4rea e selecionar onde sera clonada a
textura. Para utiliza-la, desenhe uma selecdo na area que sera corrigida, e com a selecdo ativa,

arraste o tragado selecionado para a rea que devera ser clonada.

Ferramenta Movimento sensivel ao contetido (Content-Aware Move Tool)

Permite que vocé mova objetos de lugar, mantendo o fundo da imagem de modo que, muitas
vezes, ndo seja percebida a alteracdo. Para utiliza-la, selecione a ferramenta e desenhe uma
selecdo em torno do objeto ou pessoa que deseja mover. Depois, com a seleg¢do feita, mova o objeto
ou pessoa para outro lugar. O Photoshop ir4 redesenhar o fundo e dar continuidade a textura e
objetos que estavam por tras do que serd movido.

Ferramenta Olhos Vermelhos (Red Eye Tool)

Permite que reduza o efeito de olhos avermelhados provocado pelo flash das cAmeras.
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Veja, a seguir, uma figura que ilustra as Ferramentas de Retoque ja descritas.

Figura 4 - Ferramentas de Retoque, que pode auxiliar na realizacdo de pequenas corre¢des de imperfei¢cdes na
imagem.
Fonte: ADOBE PHOTOSHOP CC, 2018.

3.3 Recursos avancados

0 Photoshop se tornou famoso mundialmente pelas suas ferramentas muito poderosas de manipulacdo de
imagens e pelos diferenciais na forma de trabalhar com imagens bitmaps. Apesar de seu modelo ter sido copiado
pelos concorrentes, este software continua liderando o mercado de manipulacdo de imagens. Suas ferramentas
oferecem desde os tratamentos mais basicos, como vimos anteriormente, até tratamentos mais avangados.

Conheca, agora, ferramentas avancadas de edi¢do proporcionadas pelo aplicativo para manipulagio e tratamento
de imagens. As camadas, mascaras, filtros e efeitos tornam o software um grande diferencial no tratamento
desse tipo de arquivo e produzem imagens com efeitos comercialmente aceitaveis na publicidade mundial ou até

com efeitos artisticos que buscam aproximar a imagem de referéncias artisticas classicas.

3.3.1 Camadas

A possibilidade de trabalhar com camadas é um dos grandes trunfos do Photoshop, sendo por isso copiado pelos
seus concorrentes. Segundo Faulkner e Chavez (2016), as camadas criam niveis de trabalho como se fossem
folhas de acetato umas sobre as outras que, empilhadas, formam a imagem final, mas que podem ser separadas e
editadas individualmente, sem interferirem no trabalho umas das outras. Os autores ainda ressaltam o quanto as

camadas flexibilizam a composicao e a revisdo das imagens pela possibilidade de isola-las.

VOCE QUER LER?

Para conhecer mais o software, é possivel encontrar diversas publicacGes gratuitas e pagas. A

Q propria Adobe disponibiliza uma série de informagdes gratuitas em seu website, em forma de
tutoriais e dicas. Acesse o link e conheca mais sobre o Photoshop: <https://helpx.adobe.com/br

/photoshop/user-guide.html>.

EADD

-11 -


https://helpx.adobe.com/br/photoshop/user-guide.html
https://helpx.adobe.com/br/photoshop/user-guide.html

Existem duas formas de manipular camadas no Photoshop: por meio do menu Camadas (Layers) ou pelo painel
de encaixe Camadas (Layers). Sempre que vocé insere uma camada em seu arquivo, ela vai sendo empilhada em
cima da anterior. Lembre-se de que quando vocé quiser trabalhar com uma camada, sera necessario seleciona-la
no painel de encaixe.

Figura 5 - Painel de encaixe Camadas (Layers), no qual é possivel configurar as camadas e reordena-las.
Fonte: ADOBE PHOTOSHOP CC, 2018.
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Para criar uma nova camada, vocé pode clicar na folha ao lado da lixeira no painel de Camadas ou no Menu
Camada (Layer) > Nova (New) > Camada (Layer). Além disso, ao importar ou colar um arquivo para o arquivo
atual, o Photoshop cria uma nova camada imediatamente, e a separa das demais. Para excluir camadas, o
caminho é semelhante: no Painel de encaixe, clique no icone da lixeira apds selecionar a camada. No menu, clique
em Camada (Layer) > Apagar (Delete) > Camada (Layer). Clique a seguir para conhecer o que este software
possibilita criar.

0 software permite que camadas sejam ocultadas facilmente, apenas clicando no icone do olho ao lado da
imagem de visualizacdo da camada no painel de encaixe; da mesma forma, é possivel reexibi-las clicando no
mesmo icone.

E possivel, ainda, bloquear as camadas para edigio clicando no icone de cadeado que esta acima da lista de
camadas.

Um recurso muito interessante e util é a possibilidade de bloquear altera¢des na area da transparéncia. Assim,
vocé pode alterar a imagem inteira sem mexer no que ja esta transparente. E s6 clicar no icone quadriculado ao
lado do nome Bloquear, acima da lista de camadas.

Vocé pode aplicar efeitos as camadas clicando no icone FX na barra inferior do painel. O Photoshop ira oferecer
efeitos de Blending nessa opg¢do, como Sombra Projetada, Estilos, efeitos de Mesclagem, Chanfro e Entalhe,
Sombra Interna, Sobreposi¢do de Padrao, Brilho Externo, Cetim, Tragado, e a possibilidade de poder fazer ajustes
as imagens das camadas no botdo com o icone de circulo com duas cores.

Esses efeitos sdo de alteracdo de cor e luz, principalmente, como ajustes de Tom, Brilho e Contraste, Matiz e
Saturacdo, Exposicdo, Variacdes de cor. A diferenca entre aplicar esses ajustes pelo painel é que eles podem ser
desfeitos ou ocultos facilmente pelo préprio painel.

No menu Imagem (Image) > Ajustes (Adjusts) esses mesmos ajustes estdo disponiveis, mas sdo aplicados de
forma permanente na imagem e nao podem ser desfeitos depois de algum tempo apenas utilizando o CTRL + Z,
caso tenha sido executado recentemente.

As camadas permitem também o trabalho com mascaras de transparéncia no botdo do circulo inserido no
retangulo. Isso significa que vocé pode aplicar uma mascara em sua camada que ird ocultar partes da imagem e
preservar outras. Mas isso é assunto para o préximo tépico, que tratard exatamente de mdascaras, dos famosos
filtros e dos efeitos de blending.

3.3.2 Mascaras, filtros e efeitos de blending

Antes de falar sobre as mascaras, cabe aqui explicar as ferramentas de selecdo. Na barra de ferramentas, existe
um botdo em formato de retdngulo com o contorno pontilhado, chamado Letreiro Retangular (Retangular
Marquee) (assim como existe a op¢do de ferramenta Eliptica ao clicar com o botdo direito em Letreiro
Retangular). Essas sdo as ferramentas basicas de selecdo do programa, e vocé pode utiliza-las para diversas
atividades, como alterar cores, mover partes da imagem, apaga-las etc.

Além das formas basicas, o Photoshop possui outras ferramentas. Conheca-as clicando a seguir.

Varinha Magica (Magic Wand)

Uma ferramenta consagrada para selecdo de areas e cores. A ferramenta de selecdo rapida, ainda, que surge ao
clicar no botao direito do mouse, permite que vocé selecione dreas da imagem com a mesma cor e possa executar
efeitos, filtros, mascaras, alteracao de cores etc.

Outras ferramentas

A ferramenta Lago (Lasso), a Laco Poligonal (Polygonal Lasso) e a Lago Magnético (Magnetic Lasso) permitem
que vocé desenhe uma area de selegio personalizada em torno da imagem que deseja para fazer alteragdes. Cada
uma dessas ferramentas pode ser utilizada em conjunto com outras, sempre aplicando-as com o botao SHIFT
pressionado e, para reduzir o campo de selegio, com a tecla ALT pressionada.

Além dessas ferramentas, o Photoshop possui um menu dedicado a selegdo. Nele, é possivel selecionar Tudo,
Nada, Refazer selecdo, Inverter a sele¢do, selecionar Todas as camadas, Nenhuma camada, Isolar Camadas,
Procurar camadas, além de aplicar selecdo por cor, na qual ele irad selecionar determinada cor escolhida por vocé
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em uma paleta ou com o conta-gotas, selecionar por area de foco, Selecionar e Criar uma mascara a partir da
selecdo, Aumentar ou Diminuir o raio da selegcdo que esta aplicada, torna-la mais Suave nas bordas, Editar a
selecdo, Ler e Salvar o padrdo de selecdo, entre outras.
Mascaras
As mascaras sdo um recurso muito importante para ocultar partes de uma camada e revelar partes das camadas
abaixo, além de possibilitar que vocé apague partes da imagem sem alterar a original. E possivel criar dois tipos
de mascara. Clique e conhega estes tipos e também a forma de cria-los.
Bitmaps
Dependem da resolugdo e sdo editadas com as ferramentas de pintura e selecao.
Vetoriais
Nao dependem de resolugao e sdo criadas a partir das ferramentas Forma e Caneta.
Adicionar mascara
Selecione a 4rea que deseja manter visivel, clique no painel de camadas e, depois, no botao Adicionar Mdascara de
Camada (Add Layer Mask), que tem um circulo dentro de um retangulo como icone.
Criacao de imagem
O botdo ird criar uma imagem em preto e branco com o formato que vocé havia selecionado. Elas ficardo
vinculadas e sera possivel fazer edi¢des na mascara, clicando na visualizacdo dela e utilizando a borracha ou
pincel nas cores preta e branca (ADOBE SYSTEMS, 2018).
A cor preta nas mascaras € a area que sera ocultada, e a parte em branco (ou transparente na miniatura) é a area
que sera exibida.
Vocé ainda pode aplicar alguns efeitos nessa mascara, como o desfoque, que suavizara as bordas da mascara.
Para apagar a méscara da camada, clique com o botdo direito do mouse sobre a miniatura da méscara no painel
e, em seguida, clique em Apagar Mascara de Camada (Delete Layer Mask). Para tornar o recorte da mascara
permanente, clique sobre a miniatura dela no painel e depois em Aplicar Mascara de Camada (Apply Layer Mask).
Filtros
Em seu website, a Adobe Systems (2018) recomenda que sejam aplicados Filtros inteligentes aos seus trabalhos,
pois esses tipos especificos de filtros “sao armazenados como efeitos de camadas no painel Camadas e podem ser
reajustados a qualquer momento, trabalhando nos dados da imagem original presentes no Objeto inteligente”.
Ao clicar em Converter para Filtro Inteligente (Convert to Smart Filter), a camada é transformada em um Objeto
Inteligente (Smart Object) que permite esse tipo de manipulagao segura.
A partir do menu Filtros, o Photoshop permite a aplicagdo de diversos efeitos em suas imagens, desde os que
simulam movimentos artisticos até os que buscam se aproximar de efeitos de cameras. A seguir, vocé conhecera
os filtros disponiveis no software.

e Galeria de Filtros: galeria com 47 filtros artisticos que podem ser aplicados nas camadas do seu

trabalho, com a facilidade de simular como ficard a imagem antes da aplicagao. Esses filtros possuem

carater mais relacionado a técnicas de pintura.
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Chaecoal (115%)

Figura 6 - Galeria de Filtros, que oferece uma série de filtros para as imagens, nessa imagem foi aplicado o filtro
Carvao (Charcoal), que transforma a imagem em uma textura préxima de um desenho feito com carvao.
Fonte: ADOBE PHOTOSHOP CC, 2018; Shutterstock, 2018 (com adaptagdes).

A Galeria de filtros permite a aplicagdo de diversos filtros divididos em Artisticos, Linhas de Pincéis, Desenho,
Estilizacao e Textura. Esses filtros aplicam efeitos que simulam texturas especificas, movimentos artisticos, e que
alteram cores e pigmentacdo. Alguns desses efeitos sdo: Lapis de cor; Recorte de arestas; Pincel a seco; Foto
granulada; Afresco; Néon; Toques de Tinta; Espatula; Plastificacdo; Arestas posterizadas; Pastéis
asperos; Bastido de Borrar; Esponja; Tinta-base; Aquarela, entre outros.
Além dos filtros de efeitos artisticos, o Photoshop possui uma lista de efeitos de camera, iluminagio, video, entre
outros, que podem ser aplicados diretamente no menu Filtro (Filter).
» Filtros de desfoque: Os filtros de desfoque suavizam a imagem ou a parte selecionada dela. Podem ser
utilizados para retoques ou para desfocar fundo de fotos e simular o efeito de profundidade de camera.
Entre os filtros disponiveis, temos: Médio (Average); Desfoque e Desfoque Maior (Blur & Blur More);
Desfoque de Caixa (Box Blur); e Desfoque Gaussiano (Gaussian Blur). Sobre este filtro, em especifico, a
Adobe Systems (2018) observa:

[..] quando Desfoque Gaussiano, Desfoque de caixa, Desfoque de movimento ou Desfoque de forma
sdo aplicados a area selecionada de uma imagem, eles ocasionalmente produzem resultados
visualmente inesperados perto das arestas da selecdo. Isso ocorre porque esses filtros de desfoque
usam dados da imagem de fora da area selecionada para criar os novos pixels embacados dentro da

area selecionada.

Ainda podem ser aplicados os filtros: Desfoque de Lente (Lens Blur); Desfoque de Movimento (Motion Blur);
Desfoque Radial (Radial Blur); Desfoque de Forma (Shape Blur); Desfoque Inteligente (Smart Blur); e
Desfoque de Superficie (Surface Blur).
Existe também a galeria de desfoque, com a possibilidade de aplicar mais cinco tipos de desfoque, como
Desfoque de iris, Desfoque de Campo, Desfoque de Caminho, Desfoque de Giro e Tilt-Shift, como Desfoque
de iris, Desfoque de Campo, Desfoque de Caminho, Desfoque de Giro e Tilt-Shift.

¢ Filtros de Tracados de Pincel: Os filtros de Tracados de Pincel produzem efeitos mais artisticos,

simulando arte-final com efeitos de pincel e tinta. Esses filtros podem ser aplicados na Galeria de Filtros.
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No menu, é possivel aplicar Arestas Acentuadas, Tracado Angular, Hachura, Tracado Escuro, Rastro
de Tinta, Respingo, Traco Borrifado e Sumi-e.

Filtros de Distorcao: Esses filtros oferecem efeitos de distor¢des geométricas a imagem, com efeitos 3D
e outros. Brilho Difuso, Vidro e Marola podem ser aplicados também com a Galeria de Filtros. Além deles,
é possivel aplicar os seguintes em menu especifico: Suc¢do; Coordenadas Polares; Ondulacao;
Cisalhamento; Redemoinho; Ondas; Zigue-zague.

Filtros de Ruido: Esses filtros adicionam ou removem ruido a imagem e criam texturas diferenciadas.

Sdo eles: Adicionar Ruido; Remover Manchas; Poeira e Rabiscos; Mediana; Reduzir Ruido.

Filtros de Pixelizacgao: Os filtros de Pixelizacdo definem uma sele¢do agrupando pixels com valores de
cores semelhantes, e altera a composicdo de dreas da imagem. A seguir, conheca esses filtros: Meio-Tom
em Cores; Cristalizar; Facetar; Fragmentar; Meia-Tinta; Mosaico; Pontilhar.

Filtros de Acabamento: Segundo a Adobe Systems (2018), os filtros de Acabamento criam formas
diferenciadas préximas ao 3D, padrdes de nuvens, bem como simulam efeitos de luz e reflexdo na
imagem. Também é possivel manipular objetos em espacos tridimensionais, criar objetos 3D (cubos,
esferas e cilindros) e preenchimentos de textura a partir de arquivos em tons de cinza para produzir
efeitos de iluminagdo semelhantes a 3D. Para aplica-los, utilize uma das seguintes op¢des: Nuvens;
Nuvens por Diferenca; Fibras; Reflexo de Flash; Efeitos de Iluminagao.

Filtros Tornar Nitido: Os filtros Tornar Nitido buscam o contrario do desfoque, ou seja, eles tentam
focar a area selecionada, aumentando o contraste dos pixels. Os filtros disponiveis nesse submenu s3o:
Tornar Nitido e Nitidez Maior; Tornar Arestas Nitidas e Mascara de Nitidez; Aplicacao Inteligente
de Nitidez.

Filtros de Croqui: Esses filtros - que vocé conhecerd a seguir - adicionam efeitos de textura as imagens,

semelhantes a efeitos artisticos ou de desenhos a mao livre. Podem ser utilizadas as seguintes variantes
desse filtro: Baixo-Relevo; Giz e Carvio; Carvao; Cromo; Crayon Conté; Bico de Pena; Matriz de
Meio-Tom; Papel de Carta; Fotocopia; Gesso; Reticulagio; Estampa; Arestas Rasgadas; Papel
Molhado.

Filtros de Estilizacao: Segundo a Adobe Systems (2018), “Os filtros de Estilizacdo produzem um efeito

pintado ou impressionista em uma selecdo”. Sdo eles: Difusao; Entalhe; Extrusao; Indicacao de
Arestas; Arestas Brilhantes; Solarizacao; Ladrilhos; Tracado do Contorno; Vento.

Filtros de Textura: Os filtros de Textura simulam a aparéncia de profundidade ou substancia. Também
podem adicionar uma aparéncia organica. Os seguintes filtros de textura estao disponiveis no Photoshop:
Craquelé; Granulado; Ladrilhos do Mosaico; Bordado; Vitral; Texturizador.

Filtros de Video: O submenu Video contém os filtros Desentrelacamento e Cores NTSC, especificos
para imagens que serdo utilizadas em videos. O primeiro filtro suaviza imagens em movimento

capturadas em video, ja o segundo restringe a gama de cores as aceitaveis para reproducio em televisio.

3.3.3 Canais e Recortes

Canais sdo informagdes sobre as cores da imagem. Em uma imagem RGB, os canais existentes sdo vermelho,
verde, azul e compostos. Essas informacdes de cores podem ser alteradas no painel de encaixe de Canais (
Channels). Ao abrir ou criar um arquivo, ele automaticamente criard os canais de cores, de acordo com o modo
de cor utilizado. Vocé pode edita-los isoladamente ou criar novos canais para editar e ndo perder a informacgado
de cor original do seu arquivo.

Agora que vocé ja conhece as ferramentas basicas e avangadas do Photoshop, vocé descobrira, na sequéncia,

como manipular imagens e textos nesse software. Vamos 1a?
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3.4 Aplicacao

Querida por muitos e assustadora para outros, a manipulacdo digital de imagens tornou-se um mercado
crescente e de grande repercussdo, principalmente na publicidade mundial. Com o advento das redes sociais, a
realidade fotografica tornou-se mais alterada ainda com a aplicacdo dos filtros disponiveis em varios aplicativos,

que corrigem iluminacdo, textura e detalhes em imagens digitais.

Figura 7 - Comparativo de imagens sem e com digital retouch.
Fonte: [ulian Valentin, Shutterstock, 2018.

0 chamado digital retouch de imagens criou um perfil totalmente novo de profissional, que nao é o fotografo,
nem o diretor de arte: ele é uma pessoa dedicada a transformar as imagens fotografadas digitalmente em fotos
de altissima qualidade e comercialmente aceitas. Existem hoje, inclusive, escritérios exclusivos desse tipo de
servico nos quais os profissionais recebem de agéncias de publicidade ou de fotégrafos o material que sera

retocado.

VOCE QUER LER?

O termo “pods-fotografia” é utilizado para denominar as manipulagdes aplicadas em imagens

Q digitais para que elas se adéquem ao perfil aceito pelo mercado publicitario e até para as redes
sociais. Saiba mais sobre esse assunto no artigo “A fotografia na era de sua reprodutibilidade
digital”, de Joel de La Laina Sene: <https://jornal.usp.br/artigos/a-fotografia-na-era-de-sua-
reprodutibilidade-digital />.
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Esse processo nio é novidade, nem exclusividade do meio digital: ele existe ha muito tempo. Segundo Lopes e
Bellé (2018), é possivel encontrar imagens de 1850 com montagens feitas a partir de varias fotografias e, ja no
século XX, encontramos modifica¢des feitas diretamente nos filmes, como pequenas corre¢oes e até coloracio da

imagem, originalmente em preto e branco.

3.4.1 Manipulagcdo de imagem

As ferramentas de manipulagdo de imagem que o Photoshop oferece vao desde as mais simples — como os filtros
de Desfoque, que suavizam areas selecionadas da imagem (ou toda a imagem, caso ndo haja uma selecdo
definida) - até as mais complexas - como as ferramentas de recuperacdo, que modificam a pele e escondem
“imperfeicdes”, como manchas e espinhas, por exemplo.

Vocé ndo precisa conhecer técnicas mais avancadas de manipulagdo de fotos para poder fazer pequenas
alteracdes em imagens. Para iniciar, é muito simples: pegue uma foto com espinhas ou manchas na internet, sem
manipulagdo. Vocé pode também usar uma foto antiga, com desgaste, que é possivel recupera-la. Agora, é preciso

apenas utilizar as ferramentas de Clone (carimbo) ou o Pincel de Recuperacdo (que se assemelha a um curativo).

VOCE QUER VER?

Existem varios videos na internet que mostram formas de fazer o digital retouch de pele para

@)

K que ela ndo parega modificada. Ana Claudia Oshiro faz um 6timo timelapse em portugués
mostrando todo o processo, passo a passo. Confira em: <https://www.youtube.com/watch?
v=EC345EV9IXU>.

Outros ajustes ndo modificam a estrutura da imagem e podem resolver problemas relacionados a iluminagdo da
foto, curva de tom e até variacdo de cores da imagem. Para executa-los, clique no menu Imagem (/mage) >
Ajustes (Adjusts) > selecione o tipo de ajuste que gostaria de fazer. Ainda é possivel fazer modificagdes na
estrutura da imagem, como ajustar o angulo dos labios, ou tornar um olho simétrico ao outro. Para isso, é
necessario selecionar a area que serd alterada e utilizar as ferramentas de transformacdo, distor¢do e
deformacao.

3.4.2 Manipulag¢ao de textos

A manipulagdo de textos no Photoshop é simples e feita diretamente com a ferramenta Texto, na barra de
ferramentas. Ao clicar na imagem, iniciara a edi¢do do texto em uma nova camada vetorial com informagdes que
podem ser alteradas livremente. Ao clicar e manter pressionado o botao de Texto, sdo apresentadas outras
possibilidades para essa ferramenta, como Texto Vertical (disponibilizado verticalmente).

E possivel aplicar os mesmos filtros e efeitos nas camadas de texto, tanto pelo painel de camadas como pelo

menu de filtros do software. Lembre-se de manter a boa legibilidade do texto para néo prejudicar o seu trabalho.
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CASO

Uma empresa solicitou a criacdo de uma capa de revista para uma agéncia. Para isso, ela
enviou a foto da modelo, os textos que entrariam na capa e as referéncias do trabalho.

Para configurar o arquivo, a equipe responsavel pelo trabalho na agéncia selecionou as op¢oes
relacionadas a impressdo, dimensdes especificas da revista, modo de cor RGB e unidade de
medidas em milimetros. A equipe importou a foto, mas notou que seria necessario retirar o
fundo dela para trabalhar com uma textura diferente. Para isso, foi criada uma mascara ao
redor da modelo e ajustada para que ndo se perdessem detalhes como os fios de cabelo. A

equipe ocultou a drea ao redor da modelo, deixando, assim, a imagem livre e sem fundo.

Como ainda havia pequenas marcas na pele, foi utilizada a ferramenta de recuperacgao,
extraindo-as facilmente da imagem. Além disso, ela ainda precisava de alguns ajustes de cor e
tom. Para isso, o designer utilizou os Ajustes de imagem no menu Imagem.

Ap6s isso, foram inseridas as informagdes textuais, utilizando a ferramenta Texto. A seguir,
foram aplicados efeitos de sombra sob o texto. Finalmente, a equipe converteu o modo de cor
da imagem para CMYK, necessaria para impressoes.

Agora que vocé conheceu as ferramentas do Photoshop, vamos praticar? Pegue uma foto e realize algumas

manipulagdes para fazer uso dessas ferramentas e compreender mais sobre quais serdo os seus efeitos na

pratica. Bom trabalho!

Sintese

No decorrer deste capitulo, vocé conheceu o Adobe Photoshop, o poderoso software de manipulacdo e
tratamento de imagens bitmaps do mercado. Com a leitura deste material, vocé pode dominar os principais

aspectos, ferramentas e efeitos do Photoshop que podem ajuda-lo a ir mais além do que apenas tratar a

iluminacdo de suas fotos, conferindo aos seus trabalhos um aspecto mais profissional.

Neste capitulo, vocé teve a oportunidade de:

¢ conhecer os conceitos de utilizacdo do programa;

¢ aprender sobre a interface padrao de instalagdo e suas formas de configuragao;

¢ compreender o processo de criacdo e transformagao de formas basicas;

¢ inteirar-se sobre o uso dos pincéis oferecidos pelo programa;

¢ adquirir no¢des sobre o processo de ilustracdo e modificacdo de imagens com os pincéis;

¢ explorar as vantagens do trabalho com camadas e canais;

e compreender como aplicar e definir os filtros e efeitos que compdem o software;

¢ dominar as formas basicas de manipular imagens e textos.
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